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Before Installing v5.1 
Microsoft Internet Explorer v5.x or later is required to be installed before installing 
Predator Virtual CNC v5.1. 

Backup everything; especially your data and any customized reverse posts you have 
been using.  v5.1 is backwards compatible with v5.0, v4.x and previous v3.x releases.  

NOTE: Nomally no changes to existing reverse posts are required.  However, v5.1 of 
Predator Virtual CNC fixes a bug which may require a slight change to some reverse 
posts.  The bug fix is for 5 axis VMCs with dual rotary tables, which had the 4th and 5th 
axis rotary table register definitions backwards within the reverse post.  Simply swap the 
Move4Axis and Move5Axis register definitions within your reverse post. 

 

Why v5.1? 
By design, this release is intended to improve compatibility with a greater range of CNC 
controls and fix a few bugs.  Details of what’s new are explained throughout this 
document and within the online help. 
 

Installing v5.1 
If you are running Windows 98 or NT v4.0, and Microsoft’s Install Services has never 
been installed, v5.1 will do this automatically at the very beginning.  This will require a re-
boot prior to completing the installation of Predator Virtual CNC.  

NOTE:  Installing Predator Virtual CNC v5.1 on the Windows NT v4.0 platform requires 
service pack 6 to be installed. 

By default installation occurs in the \program files\predator software\virtual cnc 5.1 
directory.  If you were previously running v5.0 we recommend uninstalling v5.0 prior to 
installing v5.1. 

Predator Virtual CNC v5.1 by default will also install Predator Editor v6.1.  If the Predator 
Editor v6.1 is already installed it will not appear during the install.  
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Network Installations of v5.1 

By committing to store the product installation on a server, users will enjoy automatic 
healing of all critical files upon running Predator Virtual CNC.  For example, suppose a 
user accidentally deletes pvcnc.exe. Under normal circumstances he would be down and 
the software would fail to run.  With v5.1 when the user double clicks the desktop shortcut 
all critical files are checked and if necessary restored from the network server and the 
software begins to run automatically. 

The easiest way to perform a network installation is to step through the following: 

1. Copy the contents of the \virtualcnc directory on the CD to a \setup\vcnc 5.1\ or 
similar directory. 

2. Run the setup.exe from the \setup\vcnc 5.1\ directory. 

NOTE: Should any automatic healing be necessary, Predator Virtual CNC will be able to 
automatically extract the necessary files from the appropriate cab files stored in the 
\setup\vcnc 5.1\ directory.  If you install from a CD, Predator Virtual CNC will be forced to 
prompt for the CD. 

 
What’s New in v5.1? 

New! Predator CNC Editor v6.1 
V6.1 adds 40+ popular requests made by our users and fix a few bugs. 

NOTE: A 6-page document detailing the 40+ new features and enhancements is 
available upon request.  A summary of the 40+ new features is available in the What’s 
New section within the online help of the Predator CNC Editor. 

New! Complex Lathe Cycles support 
A new function keyword has been added to support complex profiles within lathe 
cycles.  Refer to the following .RPL examples: 

“G71”,multi@4   :  TurnCycle (Horizontal Box_Strategy Pocket) 
“G72”,multi@4   :  TurnCycle (Horizontal Box_Strategy) 

NOTE: The G72 does not have the pocket function keyword, which disables support for 
complex profiles.  The G71 has the additional pocket function keyword, which enables 
support for complex profiles.  Just like CNC controls that support complex profiles, 
Predator Virtual CNC offsets the profile and does not provide full collision detection. 

New! Setup Sheet HTML 
A new Setup Sheet HTML command has been added to the File menu.  This command is 
identical to the Export HTML command within the File menu.  We have duplicated it in an 
effort to transition customers to using the Setup Sheet HTML option exclusively.  This 
allows us to eliminate the old non-configurable setup sheet command with the release of 
v6.0 of the Predator Virtual CNC. 
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New! Predator CNC Editor Integration 
The Predator CNC Editor is now more accessible within Predator Virtual CNC.  At any 
time the Predator CNC Editor can be launched with the current CNC program by 
selecting CNC Program… from the Edit menu or by clicking the CNC Program toolbar 
button.  The current line will be automatically highlighted within the Predator CNC Editor. 
Finally, a new Edit button has been added within the Machine properties dialog.  Clicking 
the new Edit button will automatically launch the Predator CNC Editor with the machine’s 
current reverse post processor.   

New! Ramp style Cutter Compensation 
Support for engaging cutter compensation in a 3D linear ramp move is now supported. 

New! Modal Heidenhain Cutter Compensation 
Support for modal style Heidenhain cutter compensation has been added.  This option 
can be enabled with the following parameters: 

CYCLE_PARAM_STYLE=HEIDENHAIN 
CUTTERCOMP_STYLE=MODELESS 

New! Lathe Tool Nose Compensation 
Support for Fanuc style tool nose compensation for lathes has been added.  Just like with 
milling, the offset values are specified with D1=0.1 within the diameter section of the 
machine tab.  Existing lathe reverse posts have the typical G40, G41 and G42 codes set 
to be ignored.  To take advantage of the new lathe cutter compensation review each 
reverse post and remove the G40, G41, G42 from the ignore section of the reverse post 
and add the following: 

$CUTTERCOMP:#20 
"G40"     : CutterCompCancel 
"G41"     : CutterCompLeft 
"G42"     : CutterCompRight 

New! Configurable Cutter Compensation Move 
A new configurable cutter compensation parameter to control tool motion with external 
corners has been added.  This parameter should match the appropriate tool motion on 
the CNC.  For Example: 

[PARAMETERS] 
CutterComp_Connect=Standard 
CutterComp_Connect=Round 

NOTE: The above parameter is supported for milling and turning. 

New! Cutter Compensation Look Ahead 
New look ahead checking for cutter compensation has been added.  Like a CNC, 
Predator Virtual CNC will display an error message when processing if the compensated 
move gouges the part profile.  Like most CNCs, this look ahead check is limited to two 
moves and does not provide unlimited look ahead. 
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 New! Mitsubishi style Sub Call with Rotation 

A new function keyword has been added to the reverse post to support sub program 
calls with a rotation angle parameter.  The specified angle will rotate the sub during the 
sub call.  Refer to the following .RPM examples: 

“G22”,multi@21   :  SubProgramCallAndRotation  ; Mitsubishi style 

Pattern 21 should look like the following: 

@21:#0 
"L",int   : r_subprogram_number 
"\0"   : separator 
"H",int   : r_subprogram_gotoline 
"\0"   : separator 
"I",real   : r_rot_center_X 
"\0"   : separator 
"J",real   : r_rot_center_y 
"\0"   : separator 
"K",real   : r_real_ignore 
"\0"   : separator 
"P",int   : r_subprogram_times 

New! Absolute Zero Programming 
A new function keyword has been added to the reverse post to support absolute zero 
programming.  This is typically a G50 or G92.  Refer to the following .RPL examples: 

“G50”,multi@17   :  ChangeProgramOrigin  ; Fanuc style 

Pattern 17 should look like the following: 

@17:#0 
"X",real   : r_pos_X 
"\0"   : separator 
"Z",real   : r_pos_Z 
"\0"   : separator 
"U",real   : r_pos_U 
"\0"   : separator 
"W",real   : r_pos_V 

New! Modal Macro Call Parameter 
A new parameter has been added to support CNCs, such as the Fadal, which calls a 
Modal Macro on the same line as the G66.  Fanuc calls the Modal Macro on the following 
line.  This new parameter allows both styles to be supported. This option can be enabled 
with the following parameters: 

MACRO_MODAL_CALL=INCLUDE_DEF  ; Fadal style 
MACRO_MODAL_CALL=EXCLUDE_DEF  ; Fanuc style 
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 New! Work Offset Parameter 

A new parameter has been added to support multiple styles of work offset coordinates.  
Most CNCs specify work offset coordinates from the machine datum.  But some CNCs 
support work offset coordinates from the programming datum.  This new parameter 
allows both styles to be supported. These options can be enabled with the following 
parameters: 

WORK_OFFSET=MACHINE_DATUM  ; Fanuc style 
WORK_OFFSET=PROGRAMMING  ; Bridgeport & Anilam style 

New! Cycle Parameter 
A new parameter has been added to support multiple methods of behavior when 
returning from a canned cycle.  The Feed option will always return from the cycle in a 
feed state.  The Rapid option will always return from the cycle in a rapid state.  The 
Modal option will honor the state the CNC was in, prior to calling the cycle.  These 
options can be enabled with the following parameters: 

CYCLE_RETURN=FEED 
CYCLE_RETURN=RAPID 
CYCLE_RETURN=MODAL   ; Fanuc style 

New! Threading Registers 
Two new incremental threading registers have been added.  These options can be 
enabled within the pattern section of the reverse post: 

“U”,real  :  r_thread_pos_u  ; Haas style 
“W”,real  :  r_thread_pos_v 

New! Seimens Support 
Support for several new Seimens functions for translation, rotation and scaling.  Several 
new registers and keywords have been added.  These options can be enabled within the 
pattern section of the reverse post: 

“X”,real  :  r_rot_angle_x  ; Seimens style 
“Y”,real  :  r_rot_angle_y 
“Z”,real  :  r_rot_angle_z 
“X”,real  :  r_scale_factor_x  ; Seimens style 
“Y”,real  :  r_scale_factor_y 
“Z”,real  :  r_scale_factor_z 

In addition, the following new keywords have been added 

“ATRANS”,mult@27 :  TranslateInc ; Seimens style 
“AROT”,mult@28 :  RotationInc ; Seimens style 
“ASCALE”,mult@29 :  ScaleInc ; Seimens style 
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 New! Multiple Spindle Parameter 

A new configurable parameter can optionally be enabled to support of duplicate tool 
numbers provided they are assigned to different spindles.  This parameter should match 
the appropriate setup on the CNC machine.  For Example: 

[PARAMETERS] 
LoadTool_From_Spindle=ON  ; Enabled Duplicate T Numbers 
LoadTool_From_Spindle=OFF  ; Default 

New! Syntax Checking 
Several additional syntax checks have been added to catch common typos.  For 
example, double decimal points, double negative signs, double positive signs and 
combinations of the above per register are now verified with Predator Virtual CNC. 

New! Multiple Spindle Support 
Several new keywords have been added to load and stop multiple spindles.  For 
example: 

$TOOLCHANGE:#20 
"M26"   : LoadTool2  ; 2nd Spindle 
"M36"   : LoadTool3  ; 3rd Spindle 
"G46"   : LoadTool4  ; 4th Spindle  

$MISCELLANEOUS:#11 
"M25"   : SpindleStop2  ; 2nd Spindle 
"M35"   : SpindleStop3  ; 3rd Spindle 
"G42"   : SpindleStop4  ; 4th Spindle  

New! Head Attachments and Complex Machine Support 
Several new keywords have been added to dynamically add attachments such as right 
angle heads.  In addition, this functionality can be used to support complex machines.  
For example: 

[PARAMETERS] 
MCH_FILE=5axis_KGK_WRAH.MCH  ; With Right Angle Head 

$MISCELLANEOUS:#11 
"M155"   : LoadMachine  ; Switch to 2nd Machine 
"M156"   : RestoreMachine  ; Restores 1st Machine 

Enhanced! Tool Numbers 
Improved the processing of tool numbers so they inherit a higher internal priority then 
diameter registers even if the user defines them to be the same priority. 

Enhanced! Feed Rates with Lathe Cycles 
Support for feed rates within lathe canned cycles have been improved.   
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 Enhanced! Temporary Licensing 
Temporary licensing has been improved to show the number of days remaining in the 
status bar. 

Enhanced! Heidenhain style Radius and Chamfer Moves 
Support for Heidenhain style radius and chamfer motion when combined with cutter 
compensation has been added.   

Enhanced! Unigraphics APTCL Support 
Support for Unigraphics ATPCL files has been improved with an updated reverse post.  
Additional support for tool definitions, scanning of tools, and 4 & 5 axis positioning has 
been added. The following new parameter option has been added. 

CYCLE_PARAMS_STYLE=Unigraphics  ; Unigraphics style APTCL 

Enhanced! Animation 
Improved the performance of running Animation at the fastest speed.  In addition, we 
improved machining vertical walls with Animation’s fastest speed.  Collision detection has 
been improved to eliminate extremely subtle view dependencies.  Finally, 4 and 5 axis 
simultaneous Animation has been improved when tool shanks and tool holders are used. 

Enhanced! Solid 
Improved the display of very detailed solid stock and cut models.  An example would be a 
thin sheet metal stock with a series of punched holes.  STL Compare from a solid model 
has been improved with better image quality.  In addition, the default Automatic Sub-
Division calculations have been improved for enhanced visualization of solid models.  
Finally, several new options defined within the Edit Preferences allow Solid models to 
have Default, Improved and Best image quality.  The default option is the standard image 
quality that Predator Virtual CNC has traditionally offered.  The new options for Improved 
and Best are 2x and 4x better than the default option.  Improved image quality does 
require 2x and 4x more memory and will result in slower rendering times. 

Enhanced! Turbo 
STL Compare from a turbo model has been improved with better image quality.   

Enhanced! Deep Zoom 
STL Compare from a deep zoom view has been improved with better image quality.   

Enhanced! Machine Definitions 
Standardized all the numeric values within the machine definition to be relative from the 
machine datum.  This includes rotary axis pivot points, travel limits, spindle gauge values, 
tool change positions, and tool home positions.  Finally, Predator Virtual CNC now 
supports 4 and 5 axis initial rotary angles within the machine definitions. 

Enhanced! Rewind Button 
The rewind button now supports the initial rotary angles within the machine definitions.  
The rewind button has also been enhanced to support CNC programs with a Predator 
Header. 
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 Enhanced! Programmable Offsets 

Improved programmable offsets, typically a G10, to support incremental values.  In 
addition, support for using a G10 to load global offsets such as a G53 is now supported. 

Enhanced! Preferences 
All preferences are now stored within the registry.  Multiple users can now have their own 
preferences for background color and numerous other defaults.  This eliminates the need 
for CONFIG.INI, NSEE2000.INI and RGB.DAT files.  In addition, the Solid model dialog 
has several new options to control the display quality.  These new options are Default, 
Improved and Best.  The default option is the standard image quality that Predator Virtual 
CNC has traditionally offered.  The new options for Improved and Best are 2x and 4x 
better than the default option.  Improved image quality does require 2x and 4x more 
memory and will result in slower rendering times. 

Enhanced! Machine Preview 
The machine properties dialog’s preview area has been improved with a new green tool 
change icon.  This icon shows the tool change position relative to the other important 
machine definitions.  In addition, the machine datum is now shown with a black M.  These 
new machine preview icons will simplify creating and editing machines within Predator 
Virtual CNC.  Finally, the spindle text has been updated from sp0 to sp1 for the first 
spindle.  The additional spindle texts have been updated from sp1 to sp2, sp2 to sp3 and 
sp3 to sp4. 

Enhanced! HTML based Online Help 
Updated online help by expanding several topics with new details. 

Enhanced! STL Compare 
The option Show Design has been improved to support offset values.  The STL Compare 
has been improved to support the new configurable image quality options.  A bug was 
fixed that was reporting intermittent gouge and excess areas.  Overall image quality has 
been improved when there are dramatic differences between designed and machined.  
Extremely excessive areas within STL Compare are now displayed in a blue color. 

Enhanced! STL Export 
When exporting a Solid model the coarse and fine options have been improved to output 
a watertight STL file. 

Enhanced! STLFix 
The utility STLFix has been improved to be easier to use with several new menus, 
shortcut keys and toolbar buttons that are identical to Predator Virtual CNC.  
Improvements include a new Close command, Zoom Fit toolbar buttons, Zoom Window 
toolbar buttons, etc.  In addition, STLFix has been improved to support rotation about the 
X, Y and Z axis.  Finally, the background color has changed from black to a pale green. 

Enhanced! STL Stock and Fixture Preview 
The stock and fixture preview tab has been improved to support STL rotations and 
location changes. 
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 Enhanced! CNC Panel 
Read only CNC programs are now supported within the CNC panel.  In addition, 
programs with the Predator Header are automatically recognized during initial display.  
Finally, a bug within the CNC panel when multiple CNC programs per job has been fixed. 

Enhanced! Heidenhain Slot Cycles 
Predator Virtual CNC will automatically display a warning if the tool diameter is 
significantly smaller then the diameter of a Heidenhain slot cycle.   

Enhanced! Inspection 

The size of the inspection dialog is now adjustable.  In addition, point selection has 
been improved when feature recognition is unchecked.  Predator Virtual CNC will 
automatically default the filter selection to the Surface option after feature recognition is 
disabled.  

Enhanced! Machine Properties 
The Check Table tab has been enhanced to be more intelligent based on the machine 
type and the Moving Parts tab.  Finally, read only machine definitions are now supported. 

Enhanced! External Sub Program Calls 
The performance of processing external sub program calls is exponentially faster then 
previous releases. 

Enhanced! SAV Files 
The use of SAV files has been improved with a new preview option within the Open Job 
dialog.  A bug introduced with v4.1 and the use of SAV files has also been fixed. 

Enhanced! Circular Interpolation 
Circular Interpolation has been improved to support X, Y, and Z values with 5 digits are 
specified after the decimal point.  A bug with circular interpolation with horizontal 
machining centers has been fixed. 

Enhanced! Sequence Numbers 
Support for sequence numbers has been improved when duplicate sequence numbers 
within different sub programs are called.  A new parameter has been added: 

Enhanced! 4 and 5 Axis Support 
Support for 4 and 5 axis programming with multiple construction views has been added.  
On a Fanuc compatible CNC this is typically done with G68 and G69 codes. 

NOTE:  This method of CNC programming does not require the user to specify T codes 
within the job. 

Enhanced! Reverse Posts 
Extensive improvments to all of the included reverse posts to improve functionality and 
readability, reduce technical problems, and improve the overall ease of use.  For 
example, improved tool changes, tool home, work offsets, and canned cycles. 
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 Enhanced! Expression Support 

Supporting expressions within a reverse post processor is now easier and requires less 
typing.  Previously the expression keyword required the multristricord keyword to also be 
specified.  Within v5.1 of Predator Virtual CNC the expression keyword can be used 
stand-alone and automatically applies the multistrictord functionality.  For example: 

"X",expression   : MoveX 

Enhanced! Installation 
Improved uninstall process to insure that all example machines and reverse posts are not 
uninstalled.  These files become customer data once initially installed. 

NOTE: During an install v5.1 of Predator Virtual CNC will not overwrite any existing 
example machines and reverse posts.  These files become customer data once initially 
installed. 

Enhanced! Upgrade Dialog 
The upgrade dialog automatically strips spaces and tabs for serial #s and access #s.  

Bug Fix! Inspection and Predator CNC Editor 
Fixed a bug with launching the Predator CNC Editor from within the Inspection dialog. 

Bug Fix! Scrolling with Complex Jobs 
Fixed a bug with scrolling CNC code when the JOB had two or more CNC programs. 

Bug Fix! Lathe Radius and Chamfer Moves 
Fixed a bug with lathe radius and chamfer moves within a G1, linear move. 

Bug Fix! Lathe Threading 
Fixed a bug with G76 style threading. 

Bug Fix! Lathe Cycle 
Fixed a bug with G94 style lathe cycles. 

Bug Fix! Backplot 
Fixed a bug with occasionally displaying double arcs one on top of another. 

Bug Fix! Surfcam INC support 
Fixed two bugs with Surfcam’s part edge style programming when machining full arcs 
and arc to arc profiles.  Fixed an intermittent bug with transferring the tool height for 
chamfer tools.  Finally a bug machining ID threads from Surfcam’s INC files has been 
fixed. 

Bug Fix! Mastercam C-Hook 
Fixed a bug with the Mastercam C-Hook and Predator Virtual CNC’s revision checking for 
newer NCI files. 

Bug Fix! Machine Properties 
Fixed a bug with saving the X- spindle direction within the machine properties. 
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 Bug Fix! Lathe Holder and Insert Depth 

Fixed a bug with lathe holders and insert depths with large diameter parts.  The depth for 
lathe holders and inserts are now a fixed percentage of the holder width. 

Bug Fix! Dual Rotary Tables 
Fixed a bug with 5 axis VMCs with dual rotary tables, which had the 4th and 5th axis rotary 
table register definitions backwards within the reverse post. 

Bug Fix! Export CADL 
Fixed a bug with exporting CADL files from lathe jobs.  In addition a bug with user 
specified paths has been fixed. 

Bug Fix! Export SURFCAM INC 
Fixed a bug with exporting SURFCAM INC files. 

Bug Fix! Export MASTERCAM NCI 
Fixed a bug with exporting Mastercam NCI files. 

Bug Fix! Cutter Compensation in the NC Panel 
Fixed a bug with displaying the status when canceling diameter compensation in the NC 
panel. 

 

For the latest on Predator Virtual CNC, check our web site at 
http://www.predator-software.com 
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